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1. Introduction
AR

Welcome to your new KD2 Pro Thermal Properties Ana-
lyzer. This guide is designed to help you understand and
use your instrument to the best of its capability.

About the KD2 Pro

The KD2 Pro is a handheld device used to measure ther-
mal properties. It consists of a handheld controller and
sensors that can be inserted into the medium you wish to
measure. The single-needle sensors measure thermal con-
ductivity and resistivity; while the dual-needle sensor also
measures volumetric specific heat capacity and diffusivity.
Further details about the measurements and how they’re
made are given in chapters 2 and 3 of this guide. The KD2
Pro has many new and improved features over the original
KD2:

* Extended temperature range: The KD2 Pro can
now take readings between -50 and 150°C.

* Multiple sensor support: Unlike its predecessor,
the KD2 Pro now offers three sensors to choose
from: the standard single-needle sensor, an
extended-length single-needle sensor, and a dual-
needle sensor.

e Data Storage: Data measured by the KIDD2 Pro can
now be stored and viewed on screen.

* Download ability: Data stored in the KID2 Pro can
be downloaded to your computer using the
included KD2 Pro Utility program. This program
also helps you configure your KD2 Pro. Down-
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loaded data can be displayed in two forms: the
processed reading from the handheld device, or
the raw data itself (so that you can process the data
in another form if desired).

* Unit Selection: The KD2 Pro gives you the ability
to select data to be displayed in either SI or
English (Imperial) units.

Contact Information

* E-mail us at: kd2pro@decagon.com
* Fax us at: (509) 332-5158
* Call us at:

1-800-755-2751 (US/Canada only)

or 1-509-332-2756

Warranty Information

The KD2 Pro has a 30-day satisfaction guarantee and a
one-year warranty.

Seller’s Liability

Seller warrants new equipment of its own manufacture
against defective workmanship and materials for a period
of one year from date of receipt of equipment (the results
of ordinary wear and tear, neglect, misuse, accident and
excessive deterioration due to corrosion from any cause
are not to be considered a defect); but Seller’s liability for
defective parts shall in no event exceed the furnishing of
replacement parts FO.B. the factory where originally
manufactured. Material and equipment covered hereby
which is not manufactured by Seller shall be covered only
by the warranty of its manufacturer. Seller shall not be lia-
ble to Buyer for loss, damage or injuries to persons
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(including death), or to property or things of whatsoever
kind (including, but not without limitation, loss of antici-
pated profits), occasioned by or arising out of the installa-
tion, operation, use, misuse, non-use, repair, Or
replacement of said material and equipment, or out of the
use of any method or process for which the same may be
employed. The use of this equipment constitutes Buyet’s
acceptance of the terms set forth in this warranty. There
are no understandings, representations, or warranties of
any kind, express, implied, statutory or otherwise (includ-
ing, but without limitation, the implied warranties of mer-
chantability and fitness for a particular purpose), not
expressly set forth herein.

Repair Instructions

If your KD2 Pro should ever require a repair, call Deca-
gon at (509) 332-2756 or 1-800-755-2751 (United States
and Canada). We will ask you for your address, phone
number, your KD2 Pro’s serial number, and your current
firmware version. For non-warranty repairs, we will also
ask for a method of payment.

Before shipping your instrument to Decagon, please
contact Decagon to obtain a Request Maintenance
Authorization Number (RMA). This will allow Deca-
gon’s repair staff to keep track of your KD2 Pro. Once
you have acquired an RMA, send your KD2 Pro to Deca-
gon. Please include a document listing the complete ship-
ping address, name, and department of the person
responsible for the instrument, as well as a description of
the problem. This will better help our technicians and
shipping department to expedite repair on your KD2 Pro,
and ship it back to you.
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Please pack your KD2 Pro carefully. Ship it back in the
carrying case, preferably inside a cardboard box. Ship to:

Decagon Devices Inc.
2365 NE Hopkins Court
Pullman, WA 99163

Repair Costs

Manufacturer’s defects and instruments under warranty
will be repaired at no cost. For non-warranty repairs, costs
for parts, labor, and shipping will be billed to you.
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2. KD2 Pro Overview
I

The KD2 Pro is a battery-operated, menu-driven device
that measures thermal conductivity and resistivity, volu-
metric specific heat capacity and thermal diffusivity. The
KD2 Pro has been designed for ease of use and maximum
functionality.

Specifications

Operating Environment:
Controller: 0 to 50 °C
Sensors: -50 to +150 °C
Power: 4 AA cells
Battery Life: Approx. 1800 readings in constant use or 3
years with no use (battery drain in sleep mode < 50 uA)
Case Size: 15.5cm x9.5cm x 3.5 cm
Display: 3 cm x 6 cm, 128 x 64 pixel graphics LCD
Keypad: 6 key, sealed membrane
Data Storage: 4095 measurements in flash memory (both
raw and processed data are stored for download)
Interface: 9-pin serial
Sensor cable length: 0.8 m
Read Modes: Manual and Auto Read
Sensors:
6 cm (small) single-needle (KS-1):
Size: 1.3 mm diameter x 60 mm long
Range: 0.02 to 2.00 W/m °K (thermal conductivity)
0.5 to 50 m °K/W (thermal resistivity)
Accuracy (Conductivity): + 5% from 0.2 - 2 W/m °K
10.01 W/m°K from 0.02 - 0.2 W/m °K
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10 cm (large) single-needle (TR-1):

Size: 2.4 mm diameter x 100 mm long

Range: 0.10 to 2.00 W/m°K (conductivity)
0.5 to 10 m °K/W (resistivity)

Accuracy (Conductivity): 210% from 0.2 - 2 W/m°K
+0.02 W/m°K from 0.1 - 0.2 W/m°K

30 mm dnal-needle (SH-1):
Size: 1.3 mm diameter x 30 mm long, 6 mm spacing
Range: 0.02 to 2.00 W /m°K (conductivity)
0.5 to 50 m°K/W (resistivity)
0.1 to 1 mm?/s (diffusivity)
0.5 to 4 MJ/m-°K"! (volumetric specific heat)
Accuracy: (Conductivity) + 5% from 0.2 - 2 W/m°K
+0.01 Wm™ °K! from 0.02 - 0.2 W/m°K
(Diffusivity) +5% at conductivities above
0.1 W/m°K
(Volumetric Specific Heat) 7% at conductivi-
ties above 0.1 W/m°K
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Keypad Operation

r B

PRO

POWER: Located to the left below the

screen, this key activates and deactivates the

KD2 Pro. (Note: The device will automati-
cally turn off if not used for more than 10 minutes, except
while running in Auto Mode.)
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MENU: Located to the right below the
screen, this key cycles between the menus at
the top of the screen.

ARROW KEYS: Located in the center of the
keypad, these keys navigate within menus and
sub-menus, and modify different settings in
sub-menus. Holding down an arrow key
allows you to scroll between different options
quickly.

ESCAPE: This key backs out of sub-menus
and can be used to cancel certain actions (see
“Erase,” in “Data Menu,” Chapter 2).

ENTER: This key is used to make selections
within menus and sub-menus, and also begins

\VARN|[>E0

taking measurements (see “Making a Mea-
surement,” “Main Menu,” below).

Choosing a Sensor

Here are some things to consider when deciding which
sensor is right for you.

* The 6 cm small single-needle (KS-1) is best for ther-
mal conductivity and thermal resistivity measure-
ments on most samples, including liquids.

* The 10 cm large single-needle (TR-1) sensor is the
least accurate and is meant primarily for use in
hard materials.

* Use the 30 mm dual-needle (SH-1) sensor when dif-
fusivity and/or specific heat data are needed.
When used in liquids, this sensor is only effective
in those with high viscosities. In liquids with low
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viscosities, the heating of the needles may cause
free convection to occur, thus producing incorrect
readings.

Installing the Sensors

The KD2 Pro’s three sensors have been designed for ease
of installation and use. The following considerations
should be observed when installing the sensors.

* The sensor should be inserted all the way into
the medium to be measured.

* For the single-needle 10cm sensor, a drill bit has
been included that can be used to drill a pilot hole in
material such as stone, wood or hard soil.

* For the dual-needle sensor, the needles must
remain parallel to each other during insertion to
make an accurate reading. Therefore, take care in
tough material, which can splay the prongs and
adversely affect readings. Use the provided red tab
with pilot holes to make sure that the needles are
inserted propetly.

* Because the sensors give off a heat pulse, you must
allow a minimum of 1.5 cm of material parallel to
the sensor in all directions, or errors will occur.

« DO NOT BEND THE NEEDLES, as this can
damage the sensor beyond repair. If the needle
becomes bent, do not bend it back; contact Deca-
gon for a replacement.

* Good thermal contact between the sensors and
the medium being measured is critical for accu-
rate measurements if a hole is drilled for sensor
insertion. Make sure that the sensor fits tightly into
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the hole. Use the Arctic silver® thermal grease
included with your KD2 Pro to improve contact in
larger holes or grainy samples.

10
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3. The Menus
|

The KD2 Pro features four main menus: MAIN, DATA,
CONFIG, and AUTO (respectively). These menus access
the KID2 Pro’s features, and have been designed for ease
of use. Here is a more detailed description of each menu.

The Main Menu

The Main Menu is responsible for taking measurements
from whatever medium a sensor is inserted into.

1. MAIN

2. \H:u.uuu o,

\

r... mk ™ 5.
——— T I <

4, — ]

What you see:

1.

The thermal property reading and the currently
selected unit. The type of reading is indicated by the
letter to the left of the reading:

K = thermal conductivity

C = specific heat capacity

D = thermal diffusivity

R = thermal resistivity

NOTE: When the spinner icon is visible, press the
arrow keys to scroll through and change the current
unit and measurement type.

2. Icon showing the currently connected sensor type.

11
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3. The measurement temperature in °C or °F
4. Progress bar that displays elapsed time.
5. Indicates the status of a reading.

The purpose of the Main Menu is to take measurements.
The next section will explain how to do this.

Taking a Measurement

It is easy to take measurements with the KD2 Pro. The
KD2 Pro has the three following sensors:

* Single needle 6 cm (KS-1) - Measures thermal con-
ductivity and resistivity; most accurate for thermal
conductivity and resistivity measurements, and for
measuring fluids.

* Single needle 10 cm (TR-1) - Measures thermal
conductivity and resistivity; used for samples where
ASTM and IEEE conformity is required. Should not
be used for liquid samples.

* Dual-needle 30 mm (SH-1) - Measures thermal
conductivity, volumetric specific heat capacity, diffu-
sivity, and resistivity. Can be used in liquid samples
with high viscosities, but will produce incorrect read-
ings in low-viscosity samples.

Do the following to make a measurement:

NOTE: If the temperature of the sample medium is
different from the temperature of the needle, the nee-
dle must equilibrate to the surrounding temperature
before beginning a reading.

12



KD2 Pro Operator’s Manual
3. The Menus

Attach the appropriate sensor then turn on the KD2
Pro.

Properly insert the sensor into the material to be mea-
sured. (See “Installing the sensors” in this chapter for
instructions.)

When the KID2 Pro turns on, you should be in the
Main Menu. If not, press the Menu key until you
arrive there. Press Enter to begin the measurement.

An icon will appear on the left and right side of the
screen. The icon at left indicates the type of sensor
connected. The circular icon indicates that a reading is
underway. It will change to a thermometer icon to
indicate whether the measurement is currently in heat-
ing or cooling mode; when the thermometer is rising,
heat is applied to the needle, and when it is falling,
heat is off. A progress bar shows the elapsed time.

When the progress bar has fully darkened, the results
are displayed as follows:

N (T3] AT AT CONF TG ALTO
0122 @ Save
34.0°C O Annotate

P = 10000 2 Discard
Record 2 of 40495

On the left side of the screen are three measured
values:

13
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* Thermal Properties Reading - The calculated
thermal measurement.

e Starting Temperature - The initial tempera-
ture prior to any heating or cooling,

* Correlation Coefficient - Indicator of how well
the temperature curves correlate to the calcu-
lated thermal properties.

« £? - The r* value is the square of the correlation
coefficient. It is a measure of how well the
model fits the data (the Theory chapter of this
manual describes the model that is fit to the
data). The fraction of the variance in the data

that is “explained” by the model is equal to £,

If the model fits the data perfectly, then 2 =
1.0000. The purpose of displaying this reading
is to indicate possible problems with the data.
A good data set will give 2 values above
0.9990, except at very low thermal conductiv-
ity (e.g insulation materials). Even then,
acceptable values are above 0.9950. If the £ is
below these values, discard the data, wait fif-

teen minutes and take another reading;
On the right side of the screen are three save options:

* Save - You can save your reading as is;

* Annotate - You can attach a sample ID to your
reading;

* Discard - Cancel the current reading and return
to the main screen.

NOTE: If the data memory is full or the sample tem-
perature was unstable during a reading, an error mes-

14
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sage is displayed at the bottom of the screen. If this
should happen, you may still take readings but you will
be unable to save them to the KDD2 Pro.

How to annotate a reading: When you select the
“Annotate” option, you will see a series of lines with an
arrow above and below the first position. Use the up and
down arrow keys to select a letter or number and press
Enter to move to the next character (as shown below). If
you have annotated a previous reading, the old annotation
will remain to be modified or deleted.

__ [mAINMEIRAETSEETN
0018 I
BEF eprLss
rE = 0.9920 B —

Bacord 2 of 40495

Repeat this until you reach the last character. When fin-
ished, simply continue to press Enter until you reach the
end of the row. Holding Enter or Escape will allow you to
scroll left and right through the Sample ID quickly.

NOTE: It is important to wait for about fifteen min-
utes between readings, if the sensor is left in the same
location! If multiple measurements of a sample are made
too rapidly in succession, the sample’s temperature will
not have had enough time to equilibrate from the previous
reading, and the resulting measurement will be inaccurate.
For the best results, the sample should be as close to equi-
librium as possible. An ideal environment for equilibration

15
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can be accomplished by placing the KD2 Pro sensor and
sample in an isothermal chamber or styrofoam box.

The Data Menu

The Data Menu allows you to view stored data, download
data to a computer, and erase the data from your KD2
Pro. It also displays how many readings have been
recorded out of the total 4,095 that can be stored.

—_ECATAGTEETEN
il

Download
Eraze

Bacordad 12 of 4095

Here is description of each sub-menu:

VIEW: This menu allows you to view all data currently
stored on your KD2 Pro. Press Enter to access the read-
ings, and use the arrow keys to scroll through them. By
pressing Enter a second time, you can see more detail
about a reading,

DOWNLOAD: This menu sends the data saved in the
KD2 Pro to your computer. You have two download
options:

* Download All - This downloads the temperature
readings as well as the measured thermal proper-
ties.

* Download Summary - This downloads just the
measured thermal properties.

16
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NOTE: Your KD2 Pro comes with KD2 Pro Utility soft-
ware for use with Microsoft Windows. The Utility makes
downloading data to your computer very easy. In general,
you should use the KD2 Pro Utility to download data
instead of the download option on the KID2 Pro.

If you are unable to use the KD2 Pro Utility, you can use
terminal software to transfer the data from your KD2 Pro
to your computer. The following steps should apply to
most terminal software programs:

1. Configure your terminal software with the following
settings:
* 9600 baud
* 8 data bits, 1 stop bit, no parity
* No software/hardware flow control
¢ Append line feeds to incoming line ends
* Echo typed characters locally.

2. Connect your KD2 Pro to an available serial port on
your computer using the included RS-232 serial cable.

3. Set your terminal software to capture received data if
you want to save the data.

4. Select the appropriate option from the Download
menu in the KD2 Pro.

ERASE: This will erase all stored data on your KD2 Pro.
WARNING! This feature will completely erase all
data on your KD2 Pro, and once activated, it cannot
be undone!

17
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To erase data:
1. Press Enter to select the Erase sub-menu. The screen
“Erase all stored data?” will appear.

2. Press Enter again to erase the memory or Escape if
you decide not to continue. “Erasing,..” will be dis-
played as data is being removed, which usually takes
about 6 seconds.

3. When this is complete, you will be returned to the
Data Menu.

The Configuration Menu

The Configuration Menu allows you to change system set-

tings such as the date, time, measurement units, and also
view information about your KD2 Pro. A battery icon will
also display the remaining percentage of battery power. A
description of each sub-menu follows.

CONFIG

Date: 12 Jun, 2008

Time: 10:11

Unit=: 51

Contrast... Sl
About..

DATE: To change the current date,
1. Press Enter to select the date display.

2. The current date will appear in the center of the
screen, in day/month/year format. A pair of arrows

will be present above and below the first number.

3. Use the up & down arrow keys to change this number.

18
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4. Press Enter to move to the next number, and repeat

5.

step #3. If you need to return to the previous number,
press Escape.

When you have finished changing the last number,
press Enter and you will be returned to the Configura-
tion Menu.

TIME: To change the current time,

1.

2.

Press Enter to select the Time display.

The current time will appear in the center of the
screen, in 24-hour format. A pair of arrows will be
present above and below the first number.

Use the up & down arrow keys to change this number.

Press Enter to move to the next number, and repeat
step #3. If you need to return to the previous number,
press Escape.

When you have finished changing the last number,
press Enter and you will be returned to the Configura-
tion Menu.

UNITS: You can choose to represent measurement data
in either SI or English units. Press Enter to select an
option. When you return to the Main Menu, pressing the

19
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arrow keys allows you to scroll through and change the

current unit and measurement type.
ST and English Unit Equivalents

Thermal Thermal Volumetric Thermal
Conductivity | Resistivity | specific heat | Diffusivity
X R) © D)
SI W m °K MJ mm?2
m °K W m° °K S
English BTU hr ft °F BTU 2
hr ft °F BTU °F ft? hr

NOTE: Readings in watts per meters-degree Celsius (W/
m°C) are the same as readings in watts per meters-degree
Kelvin (W/m°K), as Celsius and Kelvin degrees are on
the same temperature scale.

CONTRAST: Allows you to change the screen contrast
level. Press Enter and follow the on-screen instructions to
modify the contrast.

CONFIG

i
Use the P and OOWH arrows
ke change the conkrask lawel.

L

ABOUT: Displays the serial number and firmware ver-
sion of your KD2 Pro.

20
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BN 171 IH | OATA ([T AL T
Serial: KOZAGU
Firmware: K02 1.08 Beta
22005 Decagon Devices, Inc.

The Auto Mode

The Auto Mode allows you to set up the KID2 Pro to take
readings automatically. You can select a measurement
time in intervals of 15 minutes. The reading will be taken
in the currently selected unit from the Main Menu, and
will begin as soon as you select this option. NOTE:
Should the KD2 Pro’s data memory ever become full
(4,095 readings), you may still take readings, but you can-
not save them until you delete some readings.

AUTAL _ 5
1. /n.nzzm—“;{ Tnberual: 00:154%

3—m 24FC Comk 10 B 5
4 /r’z = %.99?5 \6
7.
What you see:

1. Final measurement displayed in the selected unit.

2. Measurement interval. This time interval can be set
either in the CONFIG menu or in the KID2 Pro
Utility. NOTE: When the spinner icon is visible,
press the arrow keys to change the interval time.

3. Icon showing connected sensor type.

21
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4. Measurement temperature in °C or °E

5. Hourglass icon indicating that time is elapsing until
the next measurement.

6. Number of readings taken.

7. The 12 value of your data (see description of 2 value
in the “Main Menu” section of this chapter for more
details).

NOTE: The KD2 Pro Utility gives you mote options to
control how Auto Mode operates, including different time
intervals, delayed start times, and others. Refer to the next
chapter for more information.

22
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4. The KD2 Pro Utility

KD2 Pro Utility =3

File Edit Actions Help

KD2 Pro Utility
Use the KD2 Pro Utility to:

+Download measurement data to your computer.
+Erase data stored in the KD2Z Pro.

+Set the date and time.

*Configure Auto Measure mode.

+Retrieve status information.

Uge computer communication port;

COM1 Communications Port w

Status:

[ |

KD2 Pro Utility main screen

The KD2 Pro Utility is a program designed specifically for
interfacing with the KID2 Pro. Use this program to down-
load measurement data to your computer, erase measure-
ment data stored in the KID2 Pro, set the date and time,
configure the KD2 Pro to take readings automatically, and
see information about your KID2 Pro.

System Requirements

To use the KD2 Pro Utility, you must meet the following
minimum system requirements:

23
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* Microsoft Windows 98 or N'T 4 (SP 5) or better

¢ Intel Pentium Pro or better processor

* One available serial port or one available USB port
(most models of USB-to-serial adapters sup-
ported)

* Microsoft Excel 97 or better (for saving data as.xls
files)

Installation

You can install the KD2 Pro Utility using the included
CD-ROM (found in the inside cover of the KD2 Pro
Operator’s Manual). You can also download and install
the latest version of the Utility from http://www.ther-
mal.decagon.com/software

Downloading Data

This will transfer all saved measurement data on the KD2
Pro to your computer. Do the following:

1. Make sure the RS-232 cable is connected to the KDD2
Pro, and to a COM port on your computer.

2. Open the KD2 Pro Utility.

3. Choose the appropriate serial communication (COM)
port from the “Use computer communication port”
control on the main screen.

4. Click the “Download” button in the lower right-hand
corner. You can also go to the File Menu, and select
one of two options:

1) Download Summary Data - Downloads and summa-

24
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rizes the data readings, but does not display per-sec-
ond readings.

2) Download All Data - Downloads all data currently
stored in the KD2 Pro’s memory. It displays complete
data for each measurement, including per-second
readings. If you encounter an error message after
clicking this button, please refer to the Trouble-
shooting section for instructions.

Name your data file, select where it will be saved to,
and in what format. You may choose between the fol-
lowing formats:

* Microsoft Excel Workbook (*.xls);
* Comma delimited (*.csv);

* Tab delimited (*.txt);

* Raw data (also *.txt)

Click “Save” to download your data to the specified
location. The progress bar shows the status of the
download process:

KD2 Pro Utility
File Edit Actions Help

KD2 Pro Utility
Use the KD2 Pro Utility to:

*Download measurement data to your computer.
*Erase data stored in the KD2 Pro.

*Set the date and time.

*Configure Auto Measure mode.

*Retrieve status information.

Use computer communication port:

Status: Downloading data from your KD2 Pro

Cancel

KD2 Pro download dialog

25
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NOTE: You can cancel a download in progress using the
cancel button. If you cancel, no downloaded data are
saved.

How Saved Data Are Organized
Data are organized in the same way regardless of what for-
mat it was saved in. The information will be displayed into
the following columns, depending on if you are down-
loading summary data or all the data.

“Summary Data” Format

A: Measurement Time — Time and date when the
reading was taken

B: Sensor Type — model number of the sensor used for
the reading

C: K (Thermal Conductivity) — as W/m°K or BTU/hr
ft °F

D: R (Thermal resistivity)— as m°K/W or hr ft °F/
BTU

E: C (Specific Heat) — as MJ/m>°K or BTU/ft*°F
(SH-1 Sensor only)

F: D (Thermal Diffusivity) — as mm?/s or ft*/hr (SH-1
sensor only)

G: r* value — quality of fit of the data to the KD2 Pro
theoretical model.
H: Temp (T() — Initial sample temperature

I: Sample ID (if saved with measurement)

NOTE: Specific Heat and Thermal Diffusivity are only
calculated for samples measured with the dual-needle SH-

26
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1 sensor. Samples measured with other sensors will have
no data in these columns.

"All Data” Format

When you choose “Download All Data” you will see the
same columns as above, but adds the following columns:

J: Power — as W/m
K: Current — as Amps

60 new columns will also be displayed after the Current
column, each containing the individual 1-second tempera-
ture reading the KDD2 Pro uses to calculate the thermal
properties of the sample. The data is shown in units of °C
or °F, depending on how you have selected the units pref-
erence in your KD2 Pro.

The KD2 Pro Utility formats measurement dates accord-
ing to the Windows Local settings found in the Control
Panel under “Regional and Language Options” (“Regional
Settings” in Windows 98). You can override this by going
to the Preferences Menu > Data File tab, and selecting an
option under “Date/Time Format”. You can set this value
to day/month/year format, using a 12- or 24-hour clock.
(The Preferences Menu is explained in more detail later in
this chapter.)

Erasing Your Data

This will erase all data stored on your KD2 Pro.
WARNING! Once this feature is activated, all data
will be permanently deleted from the KD2 Pro, and
cannot be recovered!
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To erase the data, do the following:
1. Make sure that the RS-232 cable is connected to the
KD2 Pro, and to a COM port on your computer.

2. Choose the appropriate COM port from the “Use
computer communications port” control on the main
screen

3. Click “Erase,” in the lower left-hand corner, or select
“Erase Data...” from the File Menu. If you encounter
an error message after clicking this button, please
refer to the Troubleshooting section for instruc-
tions.

4. A progress bar shows the status of the erase process.

Setting the Date and Time

You can set the KD2 Pro’s date and time by selecting “Set
KD2 Pro Date/Time...” from the Actions Menu. This will
automatically sync the KD2 Pro’s date and time to your
computer’s time.

Setting the Auto Mode

The Auto mode of the KD2 Pro allows you to perform
automated, unattended measurements at specified time
intervals. The KDD2 Pro has pre-set measurement intervals
to select for this mode, but you can better customize how
the KD2 Pro operates in Auto mode using the KD2 Pro
Utility software. For example, you can select specific mea-
surement intervals, delayed start times, and the number of
measurements from this menu.

To configure Auto Mode with the KDD2 Pro Utility:
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1. Connect your KD2 Pro to an available serial commu-
nication port on your computer. Select the name of
your chosen serial port in the “Use computer commu-
nication port” control.

2. Choose “Configure Auto Mode...” from the Actions
Menu. The following screen appears:

* Configure Auto Mode E]
Measurement Interval : minukes

Start Time |Now w

Mumber of Measurements :

Experiment Duration 2:185 hours

Available Data Memory 4037 measurements

KD2Z Pro Date,/Time 1Z Jun 2006 12:04:51

[ Cancel H Start l

3. Choose values for Measurement Interval, Start Time,
and Number of Measurements. Each of these values is
explained below.

Measurement Interval

This is the time interval (in minutes) that you want the
KD2 Pro to wait between measurements. The instrument
must have a minimum of 15 minutes between measure-
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ments to allow for thermal gradients to dissipate. There-
fore, you can select any number over 15 minutes, up to
1440 minutes (24 hours).

Start Time

You can select when you want the auto measurement to
begin. You can choose start times ranging from “Start
Now” to delaying the start for 24 hours. If you select
“Start Now,” you will have about 30 seconds to connect
your thermal properties sensor to the KD2 Pro before the
reading will start.

Number of Measurements

This is the total number of measurements that you want
the KD2 Pro to make while in Auto Mode. The number is
between 1 and the amount of available memory. As you
change this value, the Experiment Duration value will
change. The KD2 pro will store up to 4095 readings.

Experiment Duration

This is the total amount of time that your KD2 Pro will
operate in Auto Mode, according to your measurement

interval and number of measurements selected. This gives
you an idea of how long the total Auto Mode experiment
time will take.

Available Memory

This shows how much memory you have available for
storing measurements. The KD2 Pro Utility prevents you
from defining an experiment that could exceed the
amount of available memory. If you reach the limit of
memory storage, the KID2 Pro will stop taking measure-
ments in Auto Mode.
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KD2 Pro Date/Time

This shows the current time in your KD2 Pro. If the time
is not cotrrect, click the Cancel button, then choose “Set
KD2 Pro Date/Time...” from the Actions Menu.

4. Click on the Start button. The KD2 Pro Utility will
then send your settings to the KID2 Pro.

5. Unplug the serial cable from the KID2 Pro, then con-
nect the desired thermal properties sensor to the
instrument. Your KID2 Pro is now ready to make
unattended measurements as you have programmed it.

Viewing KD2 Pro Information

Choose “View KD2 Pro Information...” from the Actions
Menu to see information about your KID2 Pro:

L] 5
b

Sernial Number: KP1230
Firmware Yersion: KP 1.15
Firmware Status: Firmware Good
Battery: 73%

Stored Measurements: 53 measurements [1.4% full)

KD2 Pro Date/Time: 12 Jun 2006 11:37.02

KD2 Pro Information screen
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This displays useful info about your KD2 Pro, including
its serial number, firmware version and status, battery sta-
tus, the number of currently stored measurements, and
current data and time in the KDD2 Pro’s operating system.

The Menus and Their Functions

The KD2 Pro Utility features four main menus. These
allow you to change program settings, as well as settings
on the K2 Pro. Below is a description of each menu and
their functions.

File

Download Summary Data/ Download All Data. Please see the
“Download Data” section of this chapter for a description
of these options.

Erase Data... Erases all data in your KD2 Pro (see instruc-
tions above).

Edit

Preferences... This sub-menu modifies program settings, and
settings for communicating with your KD2 Pro. It is
divided into three sections called “tabs”.
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1. Data File

-;;'3' Utility Preferences E]

Data File | Communications | Application

Meazurement Units

| Uze KDZ Pro Settings w

Colurmn Headers
Include column header infarmation.

Maote: "Raw Data" filer do not have column headers.

D ate/Time Format

Uze Windows Regional and Language Ophions |

Cloze

Preferences - Data File tab

Measurement Units: 1f you select “Use KD2 Pro Set-
tings,” this will save all downloaded measurement data
in the units used on the KD2 Pro. You can also
choose to override the settings in the KID2 Pro and
save your measurement data using either SI (metric) or
English units.

Column Headers: This option includes column headers
(.e. “Measurement Time,” “Sample ID,” etc.) for
downloaded data. NOTE: Raw data files do not have
header information.

Date/ Time Format: Sets the date and time format for
downloaded data files. See “How Saved Data are
Organized” for more information.
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2. Communications

* Utility Preferences

Diata File | Communications | 4pplication

Only change theze zettings if you are having trouble
communicating with your Porometer rehably.

Command Retnes | 3 [default] w
tawirmum Baud Rate | 115200 [default] |
Enable Force Find all Comm Ports if pour USE to serial
adapter doesn't appear in the comm port picker. Please

nate, enabling thiz option may alzo find comm parts that
are unavailable for uze by thiz utility.

] Foree Find all Communication Parts

Close

Preferences - Communications tab

Command Retries: 1f you encounter difficulty communi-
cating with your KDD2 Pro, you can set the number of
times the computer should automatically try re-send-
ing communications commands (up to 10).

Maxinum Band Rate: You can set the maximum baud
rate for talking to your KD2 Pro. Choose a lower
baud rate if you are not getting reliable communica-
tions from your device.

Force Find all Communications Ports: This will detect all
COM ports on your computer, and should be used if
your serial-to-USB adapter does not appear in the
“Use computer communication port” control.
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3. Application

-;;'3' Utility Preferences

Diata File | Communications | &pplication

Automatic Internet Wersion Check

Check, for updates to this Utiity as program starts.

Automatic Clock Synchronization

Keep inztrument's clock synchronized to PC.

Error Log File
[ &dd rmare detail ta emar log file.

Cloze

Preferences - Application tab

Auntomatic Internet Version Checks: 1f you select this
option, the KD2 Pro Utility will automatically check
for a newer version using Decagon's internet version
check engine. It will notify you when a newer version
is available when your computer is connected to the
internet. You can turn off the automatic check by un-
checking this option. You can manually check for
updates anytime using the “Check for Utility
Updates...” option in the Help Menu.

Automatic Clock Synchronization: Automatically sets the
KD2 Pro’s time to your computer’s time, when you
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are connected to it. (See instructions above for setting
this manually.)

Error Log File: This adds more troubleshooting mes-
sages to the error log, which can be sent to Decagon.

Actions

Set KD2 Pro Date/ Tipse... See “Setting Date and Time” sec-
tion eatrlier in this chapter for more information.

Set Auto Mode. Allows you customize how the KD2 Pro
operates in Auto mode using the KD2 Pro Utility soft-
ware. You can program specific time intervals and start
times in this menu. See “Setting the Auto Mode” section
earlier in this chapter for more information.

View KD2 Pro Information... Displays information about
your KD2 Pro. See “Viewing KD2 Pro Information” sec-
tion earlier in this chapter for more information.

Help
Help. Accesses the KIDD2 Pro Ultility help file, which pro-

vides detailed information on how to use the program.

Check for Utility Updates... 1f you select this function when
connected to the internet, the KID2 Pro Utility will check
for a newer version using Decagon's internet version

check engine. It will notify you if a newer version is avail-
able.

Check for Firmmware Updates... 1f you select this function
when connected to the internet, the KID2 Pro Utility will
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check for updates for the KDD2 Pro’s operating system
(firmware).

About KD2 Pro Utility... Displays the current program ver-
sion and Decagon contact information.

Troubleshooting
The following descriptions should help you if you encoun-
ter any difficulty using the KD2 Pro Utility.

PROBLEM: The KD2 Pro Utility tells me the com-
munication port I want to use is in use by another
application, but I don't think any other programs are
running.

SOLUTION: Some PDA synchronization software
monitor serial communication ports. Disable Microsoft's
ActiveSync or Palm's HotSync system software while
using the serial port with the KID2 Pro Utility.

PROBLEM: My USB to Serial adapter is not showing
in the communication port picker.

SOLUTION: Enable “Force find all Communication
Ports” in Preferences by going to the Edit > Preferences,
and to the Communication tab. Enable the check box at
the bottom of the screen. Enabling this option may find
other serial ports that are not available for use by the KID2
Pro Utility (for example, modems installed in your com-
puter).
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PROBLEM: Downloading data stops in the middle
with an error message saying the Utility lost connec-
tion with the KD2 Pro.

SOLUTION: A noisy serial connection can disrupt the
connection between the Utility and the KID2 Pro. If this
error happens regularly, you can try setting your baud rate
lower or increasing the number of times a command is
sent to the KD2 Pro. Choose the “Communications” tab
in Preferences to alter this.

38



KD2 Pro Operator’s Manual
5. Good Experimental Practices for the KD2 Pro

5. Good Experimental

Practices for the KD2 Pro
|

The quality of the measurements you get with the KID2
Pro can be strongly affected by your experimental tech-
nique. The following suggestions will help you to recog-
nize and avoid pitfalls in data collection so that the data
you obtain can be as accurate as possible.

1.

Keep the temperature of the sample as constant
as possible during the measurement. The measure-
ment is made by heating a needle that is placed in the
sample and monitoring either the temperature of that
needle or a second needle adjacent to the heater. The
heat input is made as small as possible to avoid ther-
mally driven redistribution of moisture in the sample.
The temperature change from heating may therefore
be only a few tenths of a degree. Sample temperature
changes during the measurement period degrade the
data and make it difficult for the inverse calculation to
find the correct values for the thermal properties. The
algorithms in the KID2 Pro are several orders of mag-
nitude less sensitive to these errors than the conven-
tional approach (plotting temperature vs. log time
during heating and looking for a linear portion of the
graph) but there can still be errors if the temperature
changes too rapidly during a measurement. To mini-
mize these sources of error:

a. In the laboratory, allow samples and sensors to

come to temperature equilibrium before the mea-

39



KD2 Pro Operator’s Manual
5. Good Experimental Practices for the KD2 Pro

surement starts. Fifteen to twenty minutes is a rea-
sonable rule of thumb.

b. Allow time between readings for temperatures
to re-equilibrate. Fifteen minutes between read-

ings isn't too much.

c. If measurements are made in an oven or a

freezer, make sure the sample temperature is rela-
tively constant before the measurement starts.

Measurements made on a sample taken from an
oven and cooling to room temperature can show
significant errors if the cool rate is too fast.

d. When measuring thermal properties in the field,

allow a minute or so after sensor insertion for

temperature equilibration.

Minimize contact resistance. In granular materials,
or in solids where a hole has been drilled to accommo-
date the sensor, there is an additional thermal resis-
tance between the heated sensor and the material into
which the sensor is inserted. This extra resistance is
called a contact resistance, and it decreases the thermal
conductivity value registered by the sensor. This effect
can be minimized by applying Arctic Silver® thermal
grease to the sensor prior to inserting it as described in
the Decagon Application Note “Reducing Contact
Resistance Errors in KD2 Thermal Properties Mea-
surements” (available at: www.decagon.com/
appnotes/contactresistance.pdf). When a hole is
drilled for the sensot, make sure the fit of the sensor
in the hole is as tight as possible. The dual needle sen-
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sor (model SH1) is less affected by contact resistance
errors than the single sensor, so thermal conductivity
in dry, granular materials are most accurate when mea-
sured with the dual needle sensor.

Use the small sensor (model KS-1) for thermal
conductivity measurements. The KS-1 (60 mm)
needle most closely approximates the infinite line heat
source and causes the least disturbance to the sample,
so it gives the most accurate measurements. Unfortu-
nately, the larger TR-1 (100 mm) needle has been
specified in ASTM and IEEE standards, and is there-
fore sometimes required. It is also difficult to drill
small holes in rock or concrete, so the large needle
may be required in these instances. In all others, we
recommend using the small needle.

Avoid convection in liquid samples. Convection is
the movement of a fluid relative to the sensor. This
can be caused by allowing the sensor to move while a
measurement is taking place, or by temperature gradi-
ents from the heated sensor itself. Convection always
increases the thermal conductivity and diffusivity read-
ings, often dramatically so. To minimize forced con-
vection (sensor movement in the fluid during
measurement) make sure the sensor is well supported
in the liquid and the sensor and liquid are on a firm
bench that will not shake during the measurement.
For free convection, the viscosity of the fluid, the ori-
entation of the sensor, and the temperature rise of the
sensor during measurement determine whether or not
convection will occur. The dual sensor can be used in
liquids; however, readings taken in liquids will not be

41



KD2 Pro Operator’s Manual
5. Good Experimental Practices for the KD2 Pro

reliable and are in effect useless. With this sensor, free
convection can occur even with a fluid as viscous as
glycerin. The single needle 6cm sensor uses much less
heater power, and is therefore more suitable for this
application. If the needle is vertical, this sensor can
measure the thermal conductivity of a fluid like glyc-
erin. If measurements need to be made on less viscous
fluids, some material (such as agar or food thickener)
needs to be added to increase viscosity (hopefully
without altering the thermal properties). With water,
agar in low concentration can stabilize it enough for a
reliable measurement. For a more detailed explanation
on measuring fluids with the KID2 Pro, refer to our
application note “Using the KD2 to Measure Thermal
Conductivity of Fluids” located at www.deca-
gon.com/appnotes/KD2_fluids.pdf

5. Don't bend the needles. Needle spacing on the dual
needle sensor is critical for accurate measurements. A
1% change in needle spacing results in a 2% error in
measurement of diffusivity and specific heat. A guide
is provided for maintaining proper needle spacing dur-
ing insertion of the sensor into a sample. The Delrin
verification block included with your system shows
the correct sensor spacing. If a needle is slightly bent,
it can be carefully straightened until the tip spacing
matches the hole spacing in the calibration block.
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5. Care and Maintenance
|

Although the KD2 Pro has been built to high construc-
tion standards, proper care must be taken to ensure con-
tinuing operation.

Cleaning and caring for the sensors

The sensors are easy to clean. The sensor needles are
stainless steel, and as such, when they need cleaning, wipe
them with a damp cloth. Take care never to bend the nee-
dles. If the sensor becomes bent, do not attempt to bend it
back; this may break it. You will need to contact Decagon
to obtain a replacement sensor.

Changing the Batteries

Although the KID2 Pro has been designed to provide an
excellent battery lifespan, the batteries will eventually
require changing. When this happens, a low-battery indi-
cator will appear in the upper left hand corner of the
screen. The KD2 Pro requires four alkaline “AA” batter-
ies. To change the batteries:

1. Carefully turn over the KDD2 Pro and locate the bat-
tery cover.

2. Place your thumb on the grooves and push upward to
loosen the cover.

3. Remove the old batteries and insert new ones. Be sure
to orient the fresh batteries properly.
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4. Update the time and date either in the Configuration
Menu of the KID2 Pro, or by using the KD2 Pro
Utility.

Troubleshooting

If you encounter problems with your KD2 Pro, refer to
the following items to see if they resolve your problem.

PROBLEM: I am getting poor or inconsistent
readings.

SOLUTION: The sensor needle(s) may not be com-
pletely inserted into the sample, or the needle(s) may be
touching the sides of the measurement container. Thermal
grease may need to be applied.

PROBLEM: The KD2 Pro says it does not recognize
the connected sensor.

SOLUTION: Make sure the connection between the
sensor and the KID2 Pro is secure, and that none of the
connector pins are bent or broken off. If the KID2 Pro still
fails to recognize the sensor, the sensor may be malfunc-
tioning. Contact Decagon for more assistance.

Verifying Sensor Performance

With your KID2 Pro, you have received two standard
materials with which you can verify that your KID2 Pro is
working correctly and maintaining accuracy: a clear vial of
glycerine (glycerol), and a plastic Delrin block.
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The glycerol should be used to verify performance of the
single-needle sensors (KS-1 and TR-1). The cap of the vial
is equipped with a septum allowing direct insertion of the
needle into the vial through the cap. To conduct a perfor-
mance verification, insert the needle fully into the glycerol.
The needle should be oriented vertically, and it is best to
turn the vial of glycerol upside-down on top of the needle,
so that any bubbles in the glycerol float to the top away
from the needle. The larger TR-1 needle is slightly longer
than the vial, and cannot be fully inserted. This will not
affect the measurement. The needle should be approxi-
mately centered in the vial, and must not be touching a
side of the vial. Before taking a measurement in the glyc-
erol, make sure that the system is not undergoing rapid
temperature drift. Even the heat from holding the vial in
your hand for a few seconds, or the cooling from direct air
conditioning flow can decrease the accuracy of the mea-
surement. It is best to place the needle and vial in an iso-
thermal environment (e.g. insulated chamber or cooler),
and allow 15 minutes of equilibration time before taking
the measurement. The thermal conductivity of the glyc-

erol is 0.285 W m™! °K! at 20 °C.

The Delrin block should be used to verify the perfor-
mance of the dual-needle (SH-1) sensor. The sensor
should be fully inserted into the pre-drilled holes in the
Delrin, and allowed to equilibrate for at least 15 minutes
before taking the measurement. Again, make sure that the
system is not undergoing rapid temperature drift. Even
the heat from holding the block in your hand for a few
seconds, or the cooling from direct air conditioning flow
can decrease the accuracy of the measurement. It is best to
place the needle and block in an isothermal environment
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(e.g insulated chamber or cooler), and allow 15 minutes of
equilibration time before taking the measurement. The
Delrin blocks have slightly different thermal conductivi-
ties from lot to lot, so the correct values for K, C, and D
for your individual Delrin block are recorded on your Cer-
tificate of Quality Assurance.
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6. KD2 Pro Theory
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Carslaw and Jaeger [1], (p. 258-262) modeled the tempera-
ture surrounding an infinite line heat source with constant
heat output and zero mass, in an infinite medium. When a
quantity of heat, Q (J m‘l) is instantaneously applied to the
line heat source, the temperature rise at distance, 7 (m)
from the source is

AT =92 exp(_er
Akt 4Dt
1

where k is the thermal conductivity (W m! K‘1), D is the
thermal diffusivity (mz/ s), and 7 1is time (s). If a constant
amount of heat is applied to a zero mass heater over a
period of time, rather than as an instantaneous pulse, the
temperature response is

q _[-r?
AT =——3_Ej O<t<t
Arrk 4Dt

2
where ¢ is the rate of heat dissipation (W/m), #; is the
heating time, and E7 is the exponential integral [2]. The
temperature rise after the heat is turned off is given by:

q (-r? { —=r?
AT =——"| —Ei FE|— || t>t,
4r kK 4Dt 4D(t-t,)

€)
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Material thermal properties are determined by fitting the
time series temperature data during heating to eq. (2), and
during cooling to eq. (3). Thermal conductivity can be
obtained from the temperature of the heated needle (sin-
gle needle), with r taken as the radius of the needle. Diffu-
sivity is best obtained by fitting the temperatures
measured a fixed distance (the KD2 Pro uses 6 mm) from
the heated needle (4 is also determined from these data).
Volumetric specific heat (W/ m3°K) is determined from 4
and D:

c=X
D

)
In each case, £ and D are obtained by a non-linear least
squares procedure [3] which searches for values of £ and
D which minimize the difference between modeled and
measured sensor temperatures. An additional linear drift
factor is included in the inverse procedure. Most experi-
ments will not occur under constant temperature condi-
tions. We assume there can be a temperature drift that is
linear with time and use an additional fitting parameter to
fit this drift. This reduces errors substantially.

The theory introduced above is based on heat flow from
an infinite line heat source. For the analytical solutions just
given to accurately describe the physical behavior of a sys-
tem, the heat source must closely approximate an infi-
nitely long, thin line. Kluitenberg et al. [4] give solutions
for pulsed cylindrical sources that are not ideal line heat
sources. For a heated cylindrical source of radius « (m) and
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length 24 (m), with temperature measured at its center, the
temperature rise during heating (0 <7< 7)) is:

AT =

i -1 - - 2 9
472k|’2/.|:1Dtu exp(-u)exp—(a/r) u]lo(Zau/r)erf(r \/ajdu

=

®)
During cooling (# > #7) it is:
AT =

r2/4D(t-t;) b

— J' u™ expu) expf@/r)?u]l, (2au/ r)erf[— \/ajdu
Ak r?/4Dt r

©)
Here, I (x) represents a modified Bessel function of order
zero, erf(x) is the error function, and # is an integration
variable. As pointed out by Kluitenberg et al. [4],

exp[-(a/r)?u]l,(2au/r)

approaches unity as a/r approaches 0, and
erf [9 Ju J
r

approaches unity as &/r approaches infinity, reducing egs.
(5) and (6) to (2) and (3).

Inversion of these equations is not practical on a micro-
controller such as the KD2 Pro uses, but we compared
results from these equations with those from equations (2)
and (3) for the sensors used in the KDD2 Pro. It was found
that eqgs. (2) and (3) fit the temperature data as well as egs.
(5) and (6), but give slightly different values for the fitting
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parameters £ and D. The differences are accounted for in
calibration, so the simpler equations (2) and (3) can be
used reliably to determine the thermal properties.

It should be pointed out that, even though a value for D is
obtained from fitting these equations to the single needle
data, that value is not a reliable estimate of D. Reliable
measurements of D are only obtained from the dual nee-
dle measurement. It can also be noted that the needle
spacing, ris squared in egs. (2) and (3). The practical effect
of this is that measurements of heat capacity and diffusiv-
ity are very sensitive to needle spacing errors. If the nee-
dles are bent so that the actual spacing is 1% different
from the assumed 6 mm spacing, the error in C and D will
be 2%.
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Appendix 1:
Table of Thermal Units

Column 1:| To convert Column 2: | To convert
SI Unit |Column 1 into | English Unit |Column 2into
Column 2, Column 1,
multiply by: multiply by:
heat Joule 0.000952 BTU 1054
heat Joule 0.239 cal 4.186
heat flux W /m? 0.00143 cal/cm? min 698
density
thermal W/m°K 0.578 BTU/hr ft °F 1.73
conductivity
thermal W/m°K 6.93 BTU in/ 0.144
conductivity hr ft2 °F
thermal m°K/W 1.73 ft hr °F/BTU 0.578
resistivity
thermal m°K/W 0.144 ft% hr °F/ 6.93
resistivity BTU in
specific heat|| j/ke°K | 2.39x10* | BTU/Ib°F 4179
diffusivity || mm?/s 0.0388 ft2/hr 25.794
diffusivity mz/s 1076 ftz/s 9.29

52



KD2 Pro Operator’s Manual
KD2 Pro CE Compliance

KD2 Pro CE Compliance

|
DECLARATION OF CONFORMITY
Application of Council Direction: 89/336/EEC

Standards to Which Conformity is EN55022: 1987

Declared: EN500082-1: 1991
Manufacturer’s Name: Decagon Devices, Inc.
2365 NE Hopkins Ct.

Pullman, Washington 99163

USA

Type of Equipment: Thermal properties meter
Model Number: KD?2 Pro
Year of First Manufacture: 2006

This is to certify that the KID2 Pro Thermal Properties
Meter, manufactured by Decagon Devices, Inc., a corpo-
ration based in Pullman, WA, USA meets or exceeds the
standards for CE compliance as per the Council Direc-
tives noted above. All instruments are built at the factory
at Decagon and pertinent testing documentation is freely
available for verification.
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